
GUÍA DE SERVICIOS POR INTERNET PARA EMPRESAS (BSO, 
SUS SIGLAS EN INGLÉS) PARA EL AÑO TRIBUTABLE 2008 

(TY08, SUS SIGLAS EN INGLÉS) 
 

SERVICIO W-2 ONLINE 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
Contiene las siguientes lecciones:  
 

• Cómo crear un formulario «W-2 Online» 

• Cómo reanudar los formularios W-2 que todavía no han presentado 

• Cómo descargar los formularios W-2 ya presentados 
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LECCIÓN 1: CÓMO CREAR UN FORMULARIO «W-2 ONLINE» 
 
Siga las siguientes instrucciones para crear hasta 20 formularios «W-2 Online». 
 
 
PASO 1: Dirija su navegador a la página titulada, Business Services Online (BSO) Welcome 

(Bienvenido a los Servicios por Internet para Empresas – BSO, siglas en inglés): 
www.segurosocial.gov/bso/bsowelcome.htm (sólo disponible en inglés). 

 

http://www.segurosocial.gov/bso/bsowelcome.htm
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PASO 2: Pulse en el botón que lee, «Log In» (Ingrese) en la página titulada, «Business Services 

Online Welcome». El sistema mostrará en pantalla la página titulada, «Log In to BSO» 
(Ingrese al BSO). 

 

 
 
PASO 3: Ingrese su «User ID» (Identificación de Usuario) y contraseña. 
 
 
PASO 4: Pulse en el encasillado que lee, «I Accept» (Acepto) después de leer las condiciones 

definidas en la página titulada, «Log In to BSO». Luego, pulse en el botón que lee, 
«Login». El sistema mostrará la página titulada, «BSO Main Menu » (página principal 
del BSO). (Para regresar a la página inicial del BSO [que lee, «Business Services Online 
Welcome], pulse en el botón que lee, «Cancel» [Cancelar].) 
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PASO 5: Pulse en el enlace que lee, «Report Wages to Social Security» (Ingrese los registros  

de salarios al Seguro Social). 
 

 
 
El sistema mostrará en pantalla la página de opciones de tareas titulada, 
«Report Wages to Social Security». 
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PASO 6: Pulse en el enlace que lee, «Submit or Resubmit Wage File, W-2 Online, and W-2c 

Online and View Submission Status» (Presentar por primera vez u otra vez un registro de 
salario, W-2 por Internet, W-2c por Internet y ver el estado de los datos presentados).  

 
El sistema mostrará en pantalla la página de opciones de tareas titulada, «Submit or Resubmit Wage 
File, W-2 Online, and W-2c Online and View Submission Status». 
 
 

(Para regresar a la página principal del BSO [titulada, «BSO Main Menu], pulse en el botón que lee, 
«BSO Main Menu».) 
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PASO 7: Pulse en el enlace que lee, «Enter Form W-2» (Ingresar los formularios W-2).   
 

 
El sistema mostrará en pantalla la página titulada, «Wage Reporting Attestation» 
(Confirmación de informe de salarios). 

 
 
PASO 8: Pulse en el botón que lee, «I Accept» (Acepto) después de leer las condiciones definidas 

en la página titulada, «Wage Reporting Attestation». Si tiene algún registro que todavía 
no ha presentado, el sistema mostrará en pantalla la página titulada, «W-2 Online 
Information the Tax Year 2008 (TY08) (Información sobre el formulario W-2 por 
Internet para el año tributable 2008 [TY08]). 
 

(Para regresar a la página principal del BSO titulada, «BSO Main Menu», pulse en el botón que lee, «I 
DO NOT Accept» [No Acepto].) 
 

Si tiene algún informe que todavía no ha presentado, el sistema mostrará en pantalla 
la página titulada, «W-2 Online Unsubmitted Reports for the TY08» (Registros de 
salarios en formato del formulario W-2 por Internet que todavía no se han 
presentado). Para el TY08, puede tener hasta un máximo de 50 registros de salarios 
que no haya presentado. Cuando haya alcanzado el límite de 50 registros que ha 
«guardado», se le requerirá que presente uno de los registros guardados antes de que 

EA 
NOTNOT
se le permita comenzar un registro nuevo.  Si tiene 49 puede continuar sin que se le 
requiera presentar los registros que ya existen pulsando en el botón que lee, «Start a 
New Report» (Comenzar un registro nuevo). Infórmese mejor, leyendo la Lección 2: 
Cómo reanudar los formularios W-2 que todavía  no ha presentados. 
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PASO 9: Después de revisar la información de inscripción, seleccione la respuesta apropiada en la 

sección que lee, «FOR WHOM ARE YOU FILING?» (¿A NOMBRE DE  QUIÉN 
PRESENTA EL INFORME?). 

 
 

  

Las respuestas a la pregunta «FOR WHOM ARE YOU FILING?» no están a las 
disposición de las personas que trabajan por cuenta propia. 

 NOTENOTA 
 

 
PASO 10: Pulse en el botón que lee, «Continue» (Continuar) después de revisar el aviso de la Ley 

de Confidencialidad y la Ley de Reducción de Trámites. El sistema mostrará en pantalla 
la página que contiene información acerca de los formularios W-2 para el año tributable 
2008. La página está titulada, «W-2 Online Employer Data for Tax Year 2008». (De lo 
contrario, pulse en el botón que lee, «Cancel» [Cancelar] para regresar a la página 
principal del BSO titulada, «BSO Main Menu»,.) 

 
PASO 11: Ingrese su información empresarial. 
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Se requiere que llene todos los encasillados marcados con un asterisco. Si pulsó en el 
botón que lee, «I am filing Forms W-2 for my company’s employees» (presento los 
formularios W-2 para los empleados de mi empresa) la información de la empresa es 
propagada de los registros de la Administración del Seguro Social (SSA, sus siglas en 
inglés), pero la puede cambiar si es necesario. 

NOTENOTA 

 
 
PASO 12: Pulse en el botón que lee, «Continue» (Continuar). El sistema mostrará en pantalla la 

página titulada, «W-2 Online Form W-2 for TY 2008» (El formulario W-2 en formato 
electrónico para el año tributable 2008, del servicio W-2 Online).  (De lo contrario, pulse 
en el botón que lee, «Cancel» [Cancelar] para regresar, sin terminar la transacción, a la 
página principal del BSO titulada, «BSO Main Menu».) 
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PASO 13: Ingrese la información del formulario W-2 en los encasillados correspondientes. 

 
PASO 14: Pulse en el botón que lee, «New W-2» (un nuevo formulario W-2) para guardar esta 

información y comenzar otro formulario W-2 nuevo. Para guardar la información de este 
W-2 y continuar a la página titulada, «W-2 Online Data Review for the TY08» (Revisión 
de la información en formato electrónico para el año tributable 2008, del servicio W-2 
Online), una vez haya terminado sus transacciones pulse en el botón que lee, «Done» 
(Terminado). Pulse en el botón que lee, «Cancel» (Cancelar) para borrar las 
transacciones hechas en este formulario W-2 y proceder a la página titulada, «W-2 Online 
Data Review for the TY08». 

 

 

NOTENOTA 

Puede ingresar hasta un máximo de 20 formularios W-2. Una vez haya ingresado la 
información del vigésimo formulario, el sistema ya no mostrará el botón que lee, 
«New W-2». 

 
  
 
PASO 15: Cuando pulse en el botón que lee, «New W-2» o «Done», posiblemente el sistema le 

muestre un aviso en pantalla. Si es así, debe revisar la información que ingresó, corregir 
lo necesario o pulse en una de las respuestas que lee, «Override» (ignorar) para cada 
aviso. Luego, pulse en el botón que lee, «Done» o «New W-2» para proceder a la página 
titulada, «W-2 Online Data Review for the TY08». 
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PASO 16: Pulse en el botón que lee, «View/Edit» (Ver o Editar) al lado del informe 

correspondiente para ver o editar la información del formulario W-2. Si quiere borrar la 
información del formulario W-2, pulse en el botón que lee, «Delete» (Borrar) al lado del 
informe correspondiente. 
 

PASO 17: Seleccione una de las siguientes opciones: 
 
«New W-2» (W-2 nuevo) para comenzar otra W-2. 

 
«Edit Employer Info» (Editar la información empresarial) para editar la información 
que anteriormente había informado referente a la empresa misma. 

 
«Go to W-3» (Ir al W-3) para ver el total de sus formularios W-3 (vease el PASO 19 para 
informarse mejor). 

 
«Save and Quit» (Guardar y Terminar) – este botón le permite guardar la información y 
salir del sistema sin presentar la información al Seguro Social. 

 
«Quit and Delete» (Terminar y Borrar) – este botón le permite salir del sistema sin 
guardar ni presentar la información al Seguro Social. 

 
PASO 18: Pulse en el botón que lee, «Go to W-3» para presentar los registros de salarios. El 

sistema mostrará en pantalla la página titulada, «W-2 Online Form W-3 for the TY08» 
(Formulario W-3 para el año tributable 2008, del servicio W-2 Online). 
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La opción que lee, «New W-2» no estará disponible si ya se han guardado 20 
formularios W-2 en el informe corriente. Igual que la opción que lee, «Go to W-3» no 
estará disponible si no se hay W-2 guardados para el empleador. NOTENOTA 
 

PASO 19: Pulse en una de las siguientes opciones: 
 
El botón que lee, «Submit Wage Report» (Presentar informe de salarios) para presentar 
los registros de salarios. Vaya al PASO 20 para informarse mejor. 
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El botón que lee, «Print Wage Report» (Imprima el informe de salarios) para imprimir o 
ver su informe de salarios antes de presentarlo al Seguro Social. Vaya al PASO 24 para 
informarse mejor. 
 
El botón de Return to W-2 Online Data Review Page (Regrese a la página de revisión 
de la información, del servicio W-2 Online). 
 

 

PASO 20: Pulse en el botón que lee, «Submit Wage Report» en la página titulada, «W-2 Online 
Form W-3 for the TY08». 

 

 

Si su «User ID» está asociado con más de un número de identificación de 
empleador  (EIN, sus siglas en inglés), entonces el sistema mostrará en pantalla la 
página relacionada con la persona que presenta los registros para que elija el EIN 
apropiado. 

 

 
 

El sistema presenta sus registros de salarios de los formularios W-2 y W-3 y mostrará en 
pantalla la página titulada, «W-2 Online Receipt Acknowledgement for the TY08» 
(Acuse recibo de los W-2 Online para el año tributable 2008 [TY08]) junto con una 
ventanilla desplegable preguntandole si desea imprimirla. Si desea imprimir el acuse 
recibo, pulse en el botón que lee, «OK» para imprimirlo, este leerá, «W-2 Online Receipt 
Acknowledgement for the TY08».  

 
 

NOTENOTA 

 
 
 De lo contrario, pulse en el botón que lee, «Cancel» (Cancelar) para cerrar la ventanilla 

sin imprimir el acuse recibo. 
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PASO 21: Oprima el botón derecho de su ratón para guardar el registro de salarios. 
 

PASO 22: Pulse en la opción que lee, «Save Target As» (Guardar el objetivo como) en el menú de 
su navegador para guardar el registro. (De lo contrario, pulse en el botón que lee, 
«Continue» [Continuar].) 

 

NOTENOTA 

Su registro de salarios estará a su disposición en su cuenta del BSO hasta la fecha 
reflejada en el Acuse Recibo de su W-2. 

 
 

PASO 23: Pulse en el botón que lee, «Continue» (Continuar). El sistema mostrará en pantalla la 
página que lee, «W-2 Online Thank You» (Agradecimiento de parte del servicio W-2 
Online). 
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PASO 24: Pulse en el botón que lee, «Print Wage Report» en la página titulada, «W-2 Online 

Form W-3 for TY08» para imprimir los registros de salarios.  El sistema mostrará en 
pantalla la página titulada, «W-2 Online Report Print» (Imprima el informe de la W-2 
Online). 

 
 

   
  2827.4561.BSO.1.0                                                                                                                                                            29 de agosto del 2008 



GUÍA DE SERVICIOS POR INTERNET PARA EMPRESAS (BSO) PARA EL AÑO TRIBUTABLE  2008 (TY08) 
SERVICIO W-2 ONLINE 

 

 
 

   
  2827.4561.BSO.1.0                                                                                                                                                            29 de agosto del 2008 



GUÍA DE SERVICIOS POR INTERNET PARA EMPRESAS (BSO) PARA EL AÑO TRIBUTABLE  2008 (TY08) 
SERVICIO W-2 ONLINE 

 

 

NOTENOTA 

Si no tiene una copia de «Adobe Acrobat Reader» en su computadora, puede 
descargar una pulsando en el enlace que aparece en el centro de la página el cual 
lee, «follow this link» (siga este enlace). 

 
PASO 25: Pulse en el enlace que lee, «Print Preview» (Vista preliminar). El sistema mostrará en 

pantalla los formularios W-2. 
 

PASO 26: Pulse en la palabra «File» (registro) que aparece a mano izquierda en la parte superior de 
la pantalla, luego pulse en la palabra «Print» (imprimir) o seleccione el icono en forma 
de impresor que aparece en la barra de herramientas de la pantalla. 
 

PASO 27: Pulse en la palabra «File» (registro) que aparece a la mano izquierda en la parte superior 
de la pantalla, luego pulse en la palabra «Close» (cerrar) después de imprimir para cerrar 
la ventanilla. El sistema lo regresará a la página titulada, «W-2 Online Report Print». 
 

PASO 28: Seleccione una de las siguientes opciones en la página titulada, «W-2 Online Report 
Print». 
 
El botón que lee, «Submit Wage Report» (Presentar registros de salarios) para enviar la 
información de los formularios W-2 y W-3 al Seguro Social. 

 

Si existe más de un EIN asociado con el «User ID», entonces el sistema mostrará en 
pantalla una ventanilla solicitando que se elija el EIN apropiado. 

NOTENOTA  
 

 
 

El botón que lee, «Return to W-3» (Regresar al formulario W-3) para regresar a la 
página titulada, «W-2 Online Form W-3 for the TY08 (Formulario W-3 para el TY08, del 
servicio W-2 Online). 
 
El botón que lee, «Return to W-2 Online Data Review» (Regresar a revisar la 
información ingresada en el servicio W-2 Online) para regresar a la página titulada, «W-2 
Online Data Review for the TY08» (Revisión de información para el TY08, del servicio 
W-2 Online). 
 
El botón que lee, «Save & Quit» (Guardar y Salir) para guardar la información de los 
formularios W-2 y W-3 que haya ingresado sin presentar la información al Seguro Social. 
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El sistema mostrará en pantalla la página lee, «Are you sure you want to save and Exit 
W-2 Online without submitting your annual wage report to SSA?» (¿Está seguro que 
quiere guardar la información y salir del servicio W-2 Online sin presentar su informe 
anual al Seguro Social?). Pulse en el botón que lee, «Yes» (Sí) para guardar los registros,  
salir y regresar a la página principal del BSO. Pulse en el botón que lee, «No» para 
regresar a la página titulada, «W-2 Online Data Review for the TY08». 
 
El botón que lee, «Quit & Delete» (Salir y Borrar) para salir de W-2 Online y borrar la  
información ingresada. Usted tendrá la oportunidad de aceptar si quiere salir y borrar los 
registros de salarios en la ventanilla que aparecerá la cual lee, «WARNING: This will 
DELETE your entire annual wage report» (AVISO: Esta a punto de borrar por completo 
su informe anual de registros de salarios). Pulse en el botón que lee, «Yes» para borrar 
todo el informe de registros salarios. Pulse en el botón que lee, «No» para regresar a la 
página titulada, «W-2 Online Data Review for the TY08». 
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LECCIÓN 2: CÓMO REANUDAR LOS FORMULARIOS W-2 QUE  
AÚN NO HA PRESENTADO 

 
Siga las siguientes instrucciones para continuar trabajando con los informes del servicio  
«W-2 Online» que ha guardado pero aún no ha presentado. El Seguro Social borrará cualquier 
informe guardado que no presente o actualice dentro de 120 días. Todos los formularios W-2 que no 
son presentados serán borrados el 11 de diciembre del 2008. 
 

 

NOTENOTA 

Se le permite tener hasta 50 informes guardados. Cada informe puede contener hasta 20 
formularios W-2. Si tiene informes que no ha presentado, el sistema automáticamente 
mostrará una lista de los informes que todavía no ha presentado tan pronto ingrese al 
servicio de «W-2 Online». 

 
PASO 1: Dirija su navegador a la página, Business Services Online Welcome (Bienvenido a los 

Servicios por Internet para Empresas): www.segurosocial.gov/bso/bsowelcome.htm (sólo 
disponible en inglés). 
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PASO 2: Pulse en el botón que lee, «Log In» (Ingrese) en la página titulada, «Business Services 

Online Welcome». El sistema mostrará la página titulada, «Log In to BSO» (Ingrese al 
BSO). 
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PASO 3: Ingrese su «User ID» (Identificación de Usuario) y contraseña. 
 
PASO 4: Pulse en el encasillado que lee, «I Accept» (Acepto) después de leer las condiciones 

definidas en la página titulada, «Log In to BSO». Pulse en el botón que lee «Login» 
(Ingrese) para ver la página principal de opciones de tareas del BSO titulada «BSO Main 
Menu». (Para regresar a la página inicial del BSO, pulse en el botón que lee, «Cancel» 
[Cancelar].) 
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PASO 5: Pulse en el enlace que lee, «Report Wages to Social Security» (Informe los registros de 

salarios al Segur Social). 
 

 
 
El sistema mostrará en pantalla la página de opciones de tareas titulada, «Report Wages to Social 
Security». 
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PASO 6: Pulse en el botón que lee, «Submit or Resubmit Wage File, W-2 Online, and W-2c 

Online and View Submission Status» (Presente por primera vez u otra vez los registros 
de salarios, el formulario W-2 en formato electrónico y el formulario W-2c en formato 
electrónico y ver el estado de los datos presentados). 
 
El sistema mostrará en pantalla la página de opciones de tareas titulada, «Submit or 
Resubmit Wage File, W-2 Online, and W-2c Online and View Submission Status». 
 
 

(Para regresar a la página principal del BSO [titulada, «BSO Main Menu], pulse en el botón que lee, 
«BSO Main Menu».) 
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PASO 7: Pulse en el enlace que lee, «Resume Unsubmitted W-2s» (Reanudar los formularios 

W-2 que aún no ha presentado).   
 

(Para regresar a la página principal del BSO [titulada, «BSO Main Menu], pulse en el botón que lee, 
«BSO Main Menu».) 
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El sistema mostrará en pantalla la página titulada, «Wage Reporting Attestation» 
(Confirmación de los informes de salarios). 
 

.  

 
 
PASO 8: Pulse en el botón que lee, «I Accept» (Acepto) después de leer las condiciones 

delineadas en la página titulada, «Wage Reporting Attestation». El sistema mostrará en 
pantalla la página titulada, «W-2 Online Unsubmitted Reports for the TY08» (Informes 
en el servicio de «W-2 Online» que aún no se han presentado pertenecientes al TY08). 
 

(Para regresar a la página principal del BSO [titulada, «BSO Main Menu], pulse en el botón que lee, 
«I DO NOT Accept» [No Acepto].) 
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PASO 9: Seleccione el botón que lee, «View/Edit» (Vea y Edite) para un informe en especifico que 

quiere ver o modificar. El sistema mostrará en pantalla la página titulada, «W-2 Online 
Data Review for the TY08». (Pulse seleccione el botón que lee, «Delete» [Borrar] para 
borrar un informe en específico. El sistema requerirá que confirme la acción de borrar el 
informe.) Las otras opciones son: 

 

 Start a New Report (Comenzar un informe totalmente nuevo) para ingresar registros de 
salarios en el formato electrónico del formulario W-2. 

 BSO Main Menu (Página principal de opciones de tareas) para regresar a la página 
principal del BSO. 

 

NOTENOTA 

Si tiene más de 50 informes pendientes sin presentar, posiblemente el botón que lee, 
«Start New Report» no aparezca en pantalla hasta que haya borrado uno de los 
informes que todavía no ha presentado. 
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NOTENOTA

El  botón que lee, «New W-2» (formulario W-2 nuevo) (en la página titulada, «W-2 
Online Data Review for the TY08) no aparecerá en pantalla si tiene la cantidad 
máxima (20) de formularios W-2 por informe  que todavía  no ha presentado. 

   
PASO 10: Pulse en el botón que lee, «Go to W-3» (proseguir al formulario W-3). El sistema 

mostrará en pantalla la página, W-2 Online Form W-3 for Tax Year 2007 (en español, 
Formulario W-3 para el año tributable 2007, del servicio W-2 Online). 
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PASO 11: Pulse en una de las siguientes opciones que aparecen en la página titulada, «W-2 

Online Form W-3 for the TY08»: 
 
El botón que lee, «Submit Wage Report» (Presentar el registro de salarios) para 
enviar la información de los formularios W-2 y W-3 al Seguro Social. 

 

Si existe más de un EIN asociado con el «User ID», entonces el sistema mostrará en 
pantalla una ventanilla solicitando que se elija el EIN apropiado. 

NOTENOTA 
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El botón que lee, «Print Wage Report» (Imprima el registro de salarios) para 
imprimir sus informes de salarios que todavía no ha presentado que se encuentran 
en la página titulada, «W-2 Online Report Print» (Imprimir informes del servicio 
W-2 Online). 

 
Pulse en el botón que lee, «Return to W-2 Online Data Review Page» para regresar a la 
página titulada, «W-2 Online Data Review Page» para revisar y/o editar el registro de 
salarios. 
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LECCIÓN 3: CÓMO DESCARGAR LOS FORMULARIOS 
W-2 YA PRESENTADOS 

 
Siga las siguientes instrucciones para descargar un expediente en formato de «Adobe» que contiene 
los formularios W-2 y W-3 referente a un informe del servicio W-2 Online presentado durante los 
últimos 30 días. 
 

 

Informes de registros  de salarios que ya han sido presentados están disponibles por 
30 días o hasta el 31 de diciembre, la  fecha ocurra primero. 

 NOTENOTA 
 

 
PASO 1: Dirija su navegador a la página titulada, «Business Services Online Welcome» 

(Bienvenido a los Servicios por Internet para Empresas): 
www.segurosocial.gov/bso/bsowelcome.htm (sólo disponible en inglés). 
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PASO 2: Pulse en el enlace que lee, «Log In» (Ingrese) en la página titulada, «Business Services 

Online Welcome». El sistema mostrará en pantalla la página titulada, «Log In to BSO» 
(Ingrese al BSO). 
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PASO 3: Ingrese su «User ID» (Identificación de Usuario) y contraseña. 
 
PASO 4: Pulse en el encasillado que lee, «I Accept» (Acepto) después de leer las condiciones 

definidas en la página titulada, «Log In to BSO. Pulse en el botón que lee, «Login» 
(Ingrese) y el sistema mostrará en pantalla la página de opciones de tareas titulada, «BSO 
Main Menu». (Para regresar a la página inicial del BSO titulada, pulse en el botón que 
lee, «Cancel» [Cancelar].) 
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PASO 5: Pulse en el enlace que lee, «Report Wages to Social Security» (Informe los 

salarios al Seguro Social). 
 

 
 
 
El sistema mostrará en pantalla la página de opciones de tareas titulada, «Report Wages to 
Social Security». 
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PASO 6: Pulse en el botón que lee, «Submit or Resubmit Wage File, W-2 Online, and W-2c 

Online and View Submission Status» (Presente por primera u otra vez los datos de 
salarios, «W-2 Online» y «W-2c Online» y ver el estado de los datos presentados). 
 
El sistema mostrará la página de opciones de tareas titulada, «Submit or Resubmit 
Wage File, W-2 Online, and W-2c Online and View Submission Status». 

 
(Para regresar a la página principal del BSO [titulada, «BSO Main Menu], pulse en el botón que lee, 
«BSO Main Menu».) 

   
  2827.4561.BSO.1.0                                                                                                                                                            29 de agosto del 2008 



GUÍA DE SERVICIOS POR INTERNET PARA EMPRESAS (BSO) PARA EL AÑO TRIBUTABLE  2008 (TY08) 
SERVICIO W-2 ONLINE 

 

 
 
PASO 7: Pulse en el enlace que lee, «Dowload Submitted W-2s» (Descargue los formularios W-2 

ya presentados).   
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El sistema mostrará en pantalla la página titulada, «Wage Reporting Attestation» 

(Confirmación de presentación de los informes de salarios). 
 

 
 
PASO 8: Pulse en el botón que lee, «I Accept» después de leer las condiciones definidas en la 

página titulada, «Wage Reporting Attestation». El sistema mostrará en pantalla la página 
titulada,  «W-2 Online Download for the TY08» (Descargue los informes para el año 
tributable 2008 (TY08) del servicio «W-2 Online»). 
 

(Para regresar a la página principal del BSO [titulada, «BSO Main Menu], pulse en el botón que lee, 
«I DO NOT Accept» [No Acepto].) 
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PASO 9: Pulse en el botón derecho de su ratón sobre el enlace de WFID que desea descargar. (El 

sistema mostrará en pantalla los formularios W-2/W-3 usando el programa de 
computadora «Adobe Acrobat Reader».) 
 

PASO 10: Pulse en la opción que lee, «Save Target As» (Guardar el objetivo con el titulo de) del 
menú que se encuentra en la parte superior de su navegador para descargar el expediente 
a su computadora. Si usted quiere ver el expediente antes de descargarlo a su 
computadora, pulse en la opción que lee, «Open in New Window» (Abrirlo en una 
ventanilla nueva). 

 
Se requiere el programa de computadora «Adobe Acrobat Reader» para ver el 
expediente  de salarios que descargó. Si no tiene una copia de éste programa de 
computadora, puede obtener una copia visitando el sitio de Internet www.adobe.com. . 

 
 
PASO 11: Para regresar a la página principal del BSO [titulada, «BSO Main Menu], pulse en el 

botón que lee, «BSO Main Menu». 
 

   
  2827.4561.BSO.1.0                                                                                                                                                            29 de agosto del 2008 

http://www.adobe.com/

	LECCIÓN 1: CÓMO CREAR UN FORMULARIO «W-2 ONLINE»
	LECCIÓN 2: CÓMO REANUDAR LOS FORMULARIOS W-2 QUE �AÚN NO HA 
	LECCIÓN 3: CÓMO DESCARGAR LOS FORMULARIOS�W-2 YA PRESENTADOS


